
Paradigme de Programare - Laborator 3
Aplicații simple ale ADT în Kotlin

Introducere

Crearea unui proiect Maven

File → New → Project → Maven → se bifează „Create from archetype” și se selectează
org.jetbrains.kotlin:kotlin-archetype-jvm → kotlin-archetype-jvm:1.4.31 → Next.

Apoi se completează denumirea proiectului, se alege locația unde se dorește a fi salvat și
se setează (opțional) id-urile pentru grup, artefact, precum și versiunea proiectului.

La final se apasă Next, iar pe fereastra următoare, Finish.

Adăugarea dependențelor Maven

Proiectele Maven au un fișier numit pom.xml (Project Object Model) care conține
informații despre proiect precum și configurările utilizate de Maven pentru a da build proiectului
(tipul de împachetare: jar/war, dependențele, plugin-urile, repozitoriile, configurări de compilare,
etc).

Se recomandă parcurgerea următoarelor resurse:
https://www.w3schools.com/cssref/css_selectors.asp

https://www.w3schools.com/cssref/css_selectors.asp


https://khttp.readthedocs.io/en/latest/
https://jsoup.org/cookbook/

În cadrul acestui laborator se vor adăuga două dependențe:
khttp - pentru cereri de tip HTTP (get, post, put, delete)
JSoup - pentru procesarea unor fișiere de tip XML, cu precădere HTML-uri.

Se deschide fișierul pom.xml din proiectul creat și se adaugă în interiorul tag-ului
<project>, următoarele linii:

<repositories>
<repository>

<id>jitpack.io</id>
<url>https://jitpack.io</url>

</repository>
</repositories>

<dependencies>
<!-- ... -->
<dependency>

<groupId>com.github.jkcclemens</groupId>
<artifactId>khttp</artifactId>
<version>0.1.0</version>

</dependency>
<dependency>

<groupId>org.jsoup</groupId>
<artifactId>jsoup</artifactId>
<version>1.13.1</version>

</dependency>
<!-- ... -->

</dependencies>

https://khttp.readthedocs.io/en/latest/
https://jsoup.org/cookbook/


Expresii regulate

O expresie regulată este o secvență de caractere care definește un tipar de căutare.
Acestea sunt utile pentru operații de căutare în principal, dar și pentru înlocuire sau pentru
împărțirea unui string într-o listă de substring-uri în funcție de tiparul ales.

Pentru mai multe detalii, vezi următoarele resurse:

https://kotlinlang.org/api/latest/jvm/stdlib/kotlin.text/-regex/
cartea „Regex Quick Syntax Reference: Understanding and using Regular

Expressions” scrisă de Zsolt Nagy
cartea „Regular Expressions Cookbook” (ediția a doua) scrisă de Jan Goyvaerts și

Steven Levithan
https://regex101.com/
cheatsheet-ul anexat laboratorului

Exemplul 1: utilizarea expresiilor regulate

Pentru acesta, se poate crea un proiect Kotlin simplu: File → New → Project → Kotlin
→ se selectează JDK-ul Java 1.8 → Next → Finish. Se dă click dreapta pe folder-ul
src/main/kotlin → New → Kotlin class/file → main → Enter → se copiaza codul de mai jos.

fun printAllRegexMatches(regex: Regex, searchString: String) {
for(item in regex.findAll(searchString)) {

println(item.value)
}
println("-".repeat(100))

}

fun main() {
val testString = "link/ether a0:b1:c2:d3:e4:f5 brd ff:ff:ff:ff:ff:ff\n" +

  "inet 192.168.0.2/24 brd 192.168.0.255 scope global eno1\n" +
"Hi,\n You can contact me at john.smith@gmail.com\n" +

  "You should use a search engine like www.duckduckgo.com\n" +
  "I'll meet you at 08:00 AM tomorrow"

val stringWithDuplicates = "one two two three three three four four four four"

https://kotlinlang.org/api/latest/jvm/stdlib/kotlin.text/-regex/
https://regex101.com/


val ipRegex = Regex("((25[0-5]|2[0-4][0-9]|[01]?[0-9][0-9]?)\\.){3}(25[0-
5]|2[0-4][0-9]|[01]?[0-9][0-9]?)")

val emailRegex = Regex("\\w+[+.\\w-]*@([\\w-]+.)*\\w+[\\w-]*.([a-
z]{2,4}|\\d+)")

val urlRegex = Regex("(https?:\\/\\/)?www\\.[-a-zA-Z0-
9@:%._\\+~#=]{2,256}\\.[a-z]{2,6}\\b([-a-zA-Z0-9@:%_\\+.~#?&//=]*)")

val timeRegex = Regex("(0?[1-9]|1[0-2]):[0-5][0-9]")
val duplicatesRegex = Regex("(\\b\\w+\\b)(?=.*\\b\\1\\b)")

// Find all matches
for(regex in listOf(ipRegex, emailRegex, urlRegex, timeRegex)) {

printAllRegexMatches(regex, testString)
}

// Match string:
println("'08:00' matchEntire:

${timeRegex.matchEntire("08:00")?.value.orEmpty()}")
println("'Tomorrow at 09:15' matchEntire:

${timeRegex.matchEntire("Tomorrow at 09:15")?.value.orEmpty()}")
println("'Tomorrow at 09:16' matches: ${timeRegex.matches("Tomorrow at

09:16")}")
println("'Tomorrow at 09:17' containsMatchIn:

${timeRegex.containsMatchIn("Tomorrow at 09:17")}")

// Remove duplicates:
println("Without duplicates:

${duplicatesRegex.replace(stringWithDuplicates, "")}")

// Find first match:
println("First duplicate:

${duplicatesRegex.find(stringWithDuplicates)?.value.orEmpty()}")

// Split by regex:
println("Regex split:

${Regex("\\d+").split("This10text20is30splitted40by50regex")}")
}

Exemplul 2: cereri HTTP de tip GET și parsarea unui HTML

După crearea proiectului conform indicațiilor din introducere, se expandează folder-ul
src/main/kotlin/ro.mike.tuiasi → se dă click dreapta pe acesta → New → Kotlin Class/File →
HTMLParser → Enter. Se copiază codul de mai jos:

package ro.mike.tuiasi

import org.jsoup.Jsoup
import org.jsoup.nodes.Document
import org.jsoup.select.Elements
import java.io.File

/**
 * @param url - Uniform Resource Locator - address of an website
 * @return HTML content corresponding to the URL as a string
 */



fun testKhttpGetRequest(url: String) : String {
val response = khttp.get(url)
println("${response.statusCode}\t ${response.headers["Content-Type"]}")
return response.text

}

/**
 * @param source - string specifying the source type (url, file, string)
 * @param url - string containing an URL, a path to a HTML file or an HTML string
 * @param baseURI - string used for the relative links inside of a local HTML file
 * @throws Exception - if the source is unknown
 */
fun testJsoup(source: String, url: String, baseURI: String?=null) {

var htmlDocument: Document? = null
htmlDocument = when(source) {

"url" -> Jsoup.connect(url).get()
"file" -> Jsoup.parse(File(url), "UTF-8", baseURI)
"string" -> Jsoup.parse(url)
else -> throw Exception("Unknown source")

}

val cssHeadlineSelector: String = "#khttp-http-without-the-bullshit h1"
val cssParagraphSelector = "#khttp-http-without-the-bullshit p"
val cssLinkSelector = "#khttp-http-without-the-bullshit > p > a"
println(htmlDocument.title())
println(htmlDocument.select(cssHeadlineSelector).text())
val paragraphs: Elements = htmlDocument.select(cssParagraphSelector)
for (paragraph in paragraphs) {

println("\t${paragraph.text()}")
}
val links = htmlDocument.select(cssLinkSelector)
println("-".repeat(100))
for (link in links) {

println("${link.text()}\n\t${link.absUrl("href")}")
}

}

fun main() {
val projectPath: String = System.getProperty("user.dir")
val htmlPath: String = "${projectPath}/src/main/resources/example.html"
val url: String = "https://khttp.readthedocs.io/en/latest/"
val htmlContent: String = testKhttpGetRequest(url)
println("*".repeat(100))
testJsoup("url", url)
println("*".repeat(100))
testJsoup("file", htmlPath, "mike.tuiasi.ro")
println("*".repeat(100))
testJsoup("string", htmlContent)

}

Se creează de asemenea un nou pachet: click dreapta pe folder-ul src/main → New →
Directory → resources → Enter. Apoi, click dreapta pe pachetul resources → New → HTML
file → HTML 5 file → example.html → Enter. Se înlocuiește conținutul cu liniile de mai jos:

<!DOCTYPE html>



<html lang="ro">
<head>

<meta charset="UTF-8">
<title>Laboratorul 3 - Paradigme de programare</title>

</head>
<body>
<h4 id="first">Acesta este un exemplu simplu de fisier HTML care trebuie parsat</h4>
<div>

<p class="custom">Acest paragraf trebuie extras utilizand un CSS selector pentru
clasa custom</p>
</div>
</body>
</html>

Exemplul 3: agendă de telefon cu operații CRUD

Să se implementeze o agendă simplă de telefon care să pună la dispoziție operațiuni de
adăugare, căutare și ștergere.

class Birth(val year: Int, val Month: Int, val Day: Int){
override fun toString() : String{

return "($Day.$Month.$year)"
}

}

class Contact(val Name: String, val Phone: String, val BirthDate: Birth){
fun Print() {

println("Name: $Name, Mobile: $Phone, Date: $BirthDate")
}

}

fun main(args : Array<String>){
val agenda = mutableListOf<Contact>()
agenda.add(Contact("Mihai", "0744321987", Birth(1900, 11, 25)))
agenda += Contact("George", "0761332100", Birth(2002, 3, 14))
agenda += Contact("Liviu" , "0231450211", Birth(1999, 7, 30))
agenda += Contact("Popescu", "0211342787", Birth(1955, 5, 12))
for (persoana in agenda){

persoana.Print()
}
println("Agenda dupa eliminare contact [George]:")
agenda.removeAt(1)
for (persoana in agenda){

persoana.Print()
}
agenda.remove(Contact("Liviu" , "0231450211", Birth(1999, 7, 30)))
println("Agenda dupa eliminare contact [Liviu]:")
agenda.removeAt(1)
for (persoana in agenda){

persoana.Print()
}

}



Exemplul 4: translator trivial bazat pe colecții de tip Map și List

Să se implementeze un translator trivial bazat pe un dicționar de coduri. Pentru aceasta se
vor utiliza colecții de tip Map și List.

fun main(args : Array<String>){
val Dictionar = hashMapOf<String, String>(

"Once" to "Odata",
"upon" to "ca",
"a" to "",
"time" to "niciodata",
"there" to "acolo",
"was" to "a fost",
"an" to "o",
"old" to "batrana",
"woman" to "femeie",
"who" to "care",
"loved" to "iubea",
"baking" to "sa gateasca",
"gingerbread" to "turta dulce",
"She" to "Ea",
"would" to "ar fi",
"bake" to "gatit",
"gingerbread" to "turta dulce",
"cookies" to "biscuiti",
"cakes" to "prajituri",
"houses" to "case",
"and" to "si",
"people" to "oameni",
"all" to "toti",
"decorated" to "decorati",
"with" to "cu",
"chocolate" to "ciocolata",
"peppermint" to "menta",
"caramel" to "caramel",
"candies" to "bomboane",
"colored" to "colorate",
"ingredients" to "ingrediente"

)

val Poveste = "Once upon a time there was an old woman who loved baking
gingerbread. She would bake gingerbread cookies, cakes, houses and
gingerbread people, all decorated with chocolate and peppermint, caramel
candies and colored ingredients."

val words1 = Poveste.split(" ")

println("Cuvintele din poveste [${words1.count()}]:")
for (word in words1)

print(word + " ")

val words2 = mutableListOf<String>()
for (word in words1){

words2.add(word.trim(',','.'))
}



println("\n")
println("Povestea tradusa ar suna cam asa:")
for (item in words2){

if (Dictionar.contains(item))
print(Dictionar[item])

else
print("[$item]")

print(" ")
}

}

Exemplul 5: Histograma distribuției cuvintelor într-un text

Se va utiliza abilitatea compilatorului Graal de a mixa limbaje. În acest caz se cere
histograma distribuției cuvintelor dintr-un text. Dacă implementarea s-ar fi realizat utilizând
numai Kotlin efortul de programare ar fi fost dublu, acesta fiind eliminat prin utilizarea
funcționalităților din limbajul R.

HINTS: Se pornește de la un proiect Kotlin JVM folosind GraalVM ca JDK, la care au fost
adăugate două fișiere:

1. Histogram.kt
2. RHistogram.java

Din java se vor utiliza următoarele biblioteci:

Nu uitați să denumiți fișierul după clasa principală (sau să verificați dacă regula este
respectată). Se vor adăuga și două variabile pentru gestiunea dimensiunii suprafeței de desenare
(plot)

Apoi se va adăuga o metodă pe care o vom folosi pentru a scrie imagini PNG desenate
din R. Parametrul E[] values este un array generic care ne permite să menținem o singură
implementare a acestei metode, în timp ce vom trimite array-uri cu tip diferit, din Kotlin.

Se va adăuga și metoda BuildHistogram pe care o vom apela ulterior din Kotlin pentru a
construi două tipuri de grafice:



1. Histograme de cuvinte considerând values ca un String[]: how = true
2. Grafice de puncte XY, considerând values ca Int[] : how = false.

Metoda se termină cu un apel la funcția care scrie imaginea PNG. Atenție, deși limbajul
R suportă mai multe funcții pentru desenarea graficelor pentru moment GraalVM exista suport
doar pentru bibliotecile lattice și grid.

După aceea vom adăuga și funcția main() în fișierul Kotlin. Vom folosi java.io.File
pentru a deschide și citi din fișierul cu numele “Fisier.txt”. Se vor construi simultan două liste:

1. trim_words care este o listă de cuvinte (numai cu litere mici), din care s-au eliminat
restul separatorilor de text (e.g. semnele de punctuație periferice)

2. chars care reprezintă o listă de litere mari, ce este creată respectând ordinea în care
acestea apar în cuvintele din trim_words.

La sfârșitul funcției main() apelăm metoda BuildHistogram din clasa Java RHistogram,
pentru a crea cele două fișiere PNG care conțin histogramele cuvintelor și a caracterelor unice.

Pentru construcția histogramelor, R folosește un mecanism prin care se asociază
caracterelor unice, numărul total de apariții (frecvența).



Template-ul celor 3 funcții pe care trebuie să le completați este prezentat mai jos.

Pentru punctul trei ar trebui să adăugați niște cod suplimentar în main() și să aveți un al
treilea apel la RHistogram.BuildHistogram(…) astfel încât să obțineți următorul grafic:



Aplicaţii şi teme

Aplicaţii de laborator:
1. Pornind de la exemplul 3:

să se implementeze operația de căutare (după nume/număr de telefon);
să se implementeze operația de actualizare a numărului de telefon;
să se extragă diagrama asociată de clasă incluzând și facilitățile cerute suplimentar ca
temă de laborator.

2. Pornind de la exemplul 4 se cere adăugarea de noi facilități:
Adăugarea de cuvinte la dicționar;
Salvarea în fișier a poveștii traduse;
Inițializarea dicționarului prin citirea lui dintr-un fișier;
Extragerea unui dicționar dintr-un fișier text de tip ebook.

Observație: studenții pot propune/implementa alte facilități, atât timp cât sunt relevante
în contextul acestei probleme.

3. Pornind de la exemplul 5:

Construiți în Kotlin același mecanism de măsurare a frecvenței elementelor unice și
afișați cuvintele unice din trim_words;
Construiți în Kotlin același mecanism de măsurare a frecvenței elementelor unice și
afișați cuvintele unice din chars;
Pentru frecvențele caracterelor unice calculate anterior să se implementeze
următoarele:

Afișarea perechilor (frecvență → caracter) sortate crescător și descrescător;
Afișarea graficelor variației de frecvență sortate anterior crescător și
descrescător și concatenarea lor într-un grafic de puncte.

Teme pe acasă:
1. Utilizând biblioteca JSoup, să se proceseze un RSS feed (de exemplu:

http://rss.cnn.com/rss/edition.rss) construind un ADT pentru stocarea datelor. ADT-ul trebuie
să conțină o listă de elemente (item-uri; un item poate fi un ADT separat), precum și
atributele generale (title, link, description, pubDate). La final, se va afișa titlul și link-ul
fiecărui item.

Mai jos aveți o structură generică a unui RSS feed:

<?xml version="1.0" encoding="UTF-8" ?>
<rss version="2.0">

<channel>
<title>PP - Laborator 3</title>
<link>http://mike.tuiasi.ro/LabPP3.pdf</link>
<description>Aplicatii simple ale ADT in Kotlin</description>
<item>

<title>Crearea unui proiect Maven</title>
<link>http://mike.tuiasi.ro/LabPP3.pdf</link>
<description>Adaugarea dependentelor in pom.xml</description>

</item>
<item>

<title>Expresii regulate</title>
<link>http://mike.tuiasi.ro/LabPP3.pdf</link>
<description>Exemple de expresii regulate in Kotlin</description>

</item>
</channel>

</rss>

2. Utilizând colecțiile și genericele să se realizeze un program consolă pentru procesarea ebook-
urilor în format text care va efectua următoarele:

http://rss.cnn.com/rss/edition.rss


Must have:
Eliminarea spațiilor multiple din text (rămâne numai unul).
Eliminarea salturilor la linie nouă multiple din text.
Detectarea și eliminarea numărului de pagină (hint: este cuprins între multe
spații albe)

Nice to have:
Detectarea și eliminarea numelui autorului (hint o secvență de două sau mai
multe cuvinte care se repetă în cadrul textului și este separată de restul textului
de mai multe spații albe și/sau caractere de control).
Detectarea și eliminarea numelui capitolului.
Identificarea setului de caractere românești și schimbarea lui cu cel utilizat
actual în caz că este maparea veche.

Hint: se pot folosi expresiile regulate.

Observație: Studentul poate alege să implementeze tema utilizând numai limbajul Kotlin
sau poate să își ușureze munca folosind orice mix de limbaje dintre cele suportate de GraalVM
(e.g. python, kotlin, R).

3. Să se implementeze o aplicație în Kotlin care să extragă toate link-urile de la un URL dat cu
o recursivitate de ordin 2 (se iau întâi toate link-urile de la URL-ul inițial, apoi pentru
fiecare link extras, se extrag din nou link-urile, păstrându-le numai pe cele care indică spre
același domeniu). Pentru aceasta se va utiliza biblioteca Jsoup și eventual khttp. După
extragerea tuturor acestor link-uri, se va crea un arbore pornind de la denumirea domeniului
(vezi figura de mai jos). După alcătuirea arborelui, se vor crea două funcții:

serializeTree - care va serializa arborele (arborele va fi scris sub formă de string sau
într-un fișier text)
deserializeTree - care va deserializa arborele (arborele se va reface dintr-un string sau
dintr-un fișier text)

Modalitatea de serializare/deserializare este la alegerea studentului. Nu este obligatoriu să
fie generică (valabilă pentru orice URL). Totuși, modalitățile de serializare generice și/sau cele
optime vor primi puncte bonus.

O variantă posibilă de serializare a arborelui într-un fișier:

stackoverflow.com: tags, users, questions
stackoverflow.com/tags: java, python, ..., sql
stackoverflow.com/users: 1144034, ..., 3732271
stackoverflow.com/users/1144034: gordon-linoff
stackoverflow.com/users/3732271: akrun
stackoverflow.com/questions: 927358, ..., 292357
stackoverflow.com/questions/927358: how-do-i-undo-the-most-recent-local-commits-in-git
stackoverflow.com/questions/292357: what-is-the-difference-between-git-pull-and-git-fetch



Anexe

1. În cazuri “disperate” (lapsus/lipsă de buffer la curs) cu privire la unele din apelurile din
codurile exemplu utilizate în lucrarea de laborator, studentul se poate duce la
https://kotlinlang.org/docs/reference/  unde prin utilizarea funcției de căutare disponibile are
acces la documentația suport pusă la dispoziție de creatorii limbajului.

2. În tabelul 1 găsiți o comparație rapidă privind echivalențele specifice paradigmei
nestructurate între CPP,  Java și Kotlin.

C/C++ Java Kotlin

int x; int x; val x : Int var x : Int

string x[2]={“str1”, “str2”}; String[] x = {“str1”, “str2”}; val x : Array<String>

double x = (4.5 > 1.2)?
7.3:9.1; Double x = (4.5 > 1.2)? 7.3:9.1; val x = if (4.5 > 1.2) 7.3 else 9.1

int x=6;
if (x>5) x ^= 4;

int x = 6;
if (x>5) x ^= 4;

var x = 6
if (x>5) x = x xor 4

int S=0;
for (int i = 1; i<100;i++)
    S += i;

int S=0;
for (int i = 1; i<100;i++)
    S += i;

var S = 0;
for (i in 1..100)
    S += i;

int x=4;
switch(x)
{
    case 1:
        printf(“x == 1”);
        break;
    case 2:
        printf(“x == 2”);
        break;
    default:
        printf(“none”);
        break;
}

int x=4;
switch(x)
{
    case 1:
        System.out.print(“x == 1”);
        break;
    case 2:
        System.out.print(“x == 2”);
        break;
    default:
        System.out.print(“none”);
        break;
}

val x = 4
when (x)
{
    1 -> print("x == 1")
    2 -> print("x == 2")
    else -> print("none")
}

string x = “aaa”, y = “aaa”;
if (x.equals(y)) { ……… }

String x = “aaa”, y = “aaa”;
if (x == y) { ……… }

String x = “aaa”, y = “aaa”;
if (x === y) { ……… }

Tabel 1. Comparație elemente de control simplu al programului între CPP/Java/Kotlin

3. În tabelul doi găsiți o paralelă între clasele/Interfețele principale specifice colecțiilor realizată
între Java și Kotlin.

Tip Java Tip Immutable Kotlin Tip Mutable Kotlin

Iterator<T> Iterator<T> MutableIterator<T>

Iterable<T> Iterable<T> MutableIterable<T>

Collection<T> Collection<T> MutableCollection<T>

Set<T> Set<T> MutableSet<T>

List<T> List<T> MutableList<T>

ListIterator<T> ListIterator<T> MutableListIterator<T>

Map<K, V> Map<K, V> MutableMap<K, V>

Tabel 2. Colecții Java vs Kotlin

4. De un real folos pot fi și așa numitele tabele pentru copiat la examen puse la dispoziție de
către academia Kotlin (de unde se poate deduce că este sprijinită adopția de masă la nivel
studențesc a limbajului sau trișarea la examen - nu este foarte clar). Tot de aici se trage
concluzia că https://blog.kotlin-academy.com s-ar putea să fie o sursă de informații mai utilă
decât stackoverflow (Vezi paginile următoare).

https://kotlinlang.org/docs/reference/
https://blog.kotlin-academy.com
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